Mac OS QuickStart
CD-R Deluxe & CD-R Pro

Packing List
The following items should be present in your CD-R bundle:

CD-R Deluxe:
- TEAC 6x24 external CDR drive (CD-R56S)
- CD-R Deluxe Software CD

CD-R Pro:
- TEAC 8x24 external CDR drive (CD-R58S)
- CD-R Pro Software CD

Both Bundles:

- SCSI Card (Adaptec 2903B)

SCSI Cable

- SCSI Terminator

(2) Blank CDR media

TEAC CD-R Drive Installation Guide

- CD-R QuickStart Guide (That’'d be this book.)

Installing the Software

A hardware installation booklet has been included with this
package; look to it for installation of the CD-Recorder. Also, if
you are new to installing software on your Mac, be aware that
you will probably have to restart the computer in between each
installation.

To install the software, make sure your CD-Recorder is
connected. If you are using a Macintosh that does not have
a standard SCSI Port, install the included SCSI card before
installing the software. (You will need to have the card in
place before installing the drivers to control the card.)

Insert the software CD into your CD-ROM or CDR drive.
There are several programs you will need to install:

Adaptec Toast - Data CD & Audio CD Authoring
TC Works SparkLE - Audio Recording, Editing and Processing

Apple QuickTime 4.0 - Offers support for more advanced
multimedia, including playback of MP3 files. The
QuickTime installer may ask for your type of internet
connection. The install is on your software CD-ROM, so an
internet connection is not necessary. It is there to help
QuickTime select the best streaming settings for your
machine.

Adaptec 2903B Driver - If you are using the 2903B SCSI
card, you will need to install this driver to recognize the
card. If you are not using the SCSI card, DO NOT install
this driver.

CD-R Pro Only:
Xing Technologies AudioCatalyst - MP3 Encoding

Adaptec Jam - Advanced Audio CD Authoring The CD-R58S
driver file MUST be placed in the same folder as the Jam
application. This file is on the CD-R Pro software CD.

CDR Introductory Tutorial

CDR (Compact Disc Recordable) media can store up to 74
minutes of stereo audio, or up to 650 megabytes of data.
CDR media can only be written to once, so the CDR authoring
software allows you to design your CD completely before you
burn it. Since the CD must contain a directory of what is on
it, and since that directory is on the write-once only media
also, all of the information must be burned to the CD at the
same time. Recording the information to a CD is done in a
Session.

While audio CD players will only recognize the first session
on the CD, many CD-ROMs will read multiple sessions. A
CD with more than one session is called a Multi-Session CD.
So, if the first session only contained 200 megabytes of
data, you could record another session behind it up to
approximately 450 megabytes. (It won’t be quite that big



because of the extra space taken by the new directory.)
Remember though, older CD-ROMs may not search for those
extra sessions.

When you get ready to design the session, you will first need
to determine the format of the CD. Some of the common CD
formats you can create with Adaptec Toast and Jam are
listed below:

Audio CD - This is the standard CD format you can use in
your Audio CD player. You can have up to 99 tracks of audio,
with adjustable silence breaks in between each track. The
audio tracks must be recorded in stereo at the CD standard
of 16 bit/44.1kHz. Remember, multiple sessions will not be
recognized by an audio CD player. If you do not have the
audio in the computer yet, you may need to use Peak LE to
record and prepare your audio.

Mac Volume - Use this format if you want to make the CD a
bootable CD. That is, it can be a Mac Startup Disk. This is
great when you are making a troubleshooting CD, or if you
just need a different system set-up occasionally. Keep in
mind that to create a Mac volume, you must set up a hard
drive or a partition exactly as you want the CD to turn out.
You will not have the opportunity to add or remove other files
when using this format.

Mac Files and Folders - When all you want to do is throw a
couple of files on a CD for personal back-up or distribute a
few select files to another user who is definitely on a
Macintosh, the Mac Files and Folders is the easiest way to
do that. Unlike a Mac Volume, you can pick and choose the
files you want, rearrange the hierarchy, and change the
names if you choose. However, you cannot make a bootable
CD with a Mac Files and Folders format.

1SO-9660 - Originally specified for DOS CD-ROM use, the
1SO-9660 now has multiple improved variations for DOS,
Windows 95, and Macintosh. This format has good back-up
capabilities for Macintosh when used as a multisession CD.
Also, since most Macintosh computers are able to read
Windows CDs, this is a great method to store cross platform
material such as JPEGs, HTML, or even basic word
processing and graphic files.

Hybrid Mac/1SO - The hybrid format allows the maximum
control when delivering files to Mac and PC users. You can
create a CD where PC users will only see the 1SO-9660
format, and the Mac users will only see the Mac Volume
format.

The CD that came with your bundle is a great example of the
Hybrid format. If you put the CD in a Macintosh, you'll see

the Mac software. If you put the CD in a Windows machine,
you'll see the Windows software.

For more information on the various types of CD formats,
check the Adaptec Toast manual. (It is in PDF format on
your software CD-ROM.)



TC Works SparkLE

Setting Up the Program

If this is the first time you've run SparkLE, there are a couple
of preferences we would recommend changing. To get to
SparkLE's preferences, start the SparkLE application, then
click on the File menu and drag down to Preferences.

Preferences
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Any changes are applisd immediatly, if possible.

Once you've made these
changes, you will probably
need to restart the
program to have the
changes take effect. So,
quit SparkLE.

o

While we're out of SparkLE, this might be a good time to
change the RAM allocation. The program defaults around
24MB. Depending on your use of the DSP and your CPU

speed, you may want to bump this up. With our G3, we
allocated 40MB of RAM, and didn't have any problems.

I_j. TO Change ylour 0 =—-——"=SPARKIE Wi —"—"——=H
L' RAM allocation,

click on the [sparKte |
SparkLE icon once, and
press Apple-l1. The info
box above should pop up.
Then, click on the pop-up
bar at top and select
Memory. Change your
"Preferred Size" to how
much RAM you need.

— Show:[ Memory =

Kind: application program

Memory Requirements

Suggested Size: 24077

K
Minimum Size: [z4077 K
Preferred Size: [42077 K

Note: This application may require 2,077 K less
memory if moved to another hard disk and wirtual
memory is turned on in the Memory control panel.

It is important to

understand that

"Preferred Size" is how

much memory the O Locked

program will try to take,
but "Minimum Size" is the minimum that the program will
accept before refusing to boot up. So, if you only change
your preferred size, that doesn't mean that the program is
actually getting any more memory, but rather that it is asking
for more. The actual allocation depends on the available
memory.

To be sure that you are getting more memory, increase the
minimum size as well. This way, if the program cannot get
the memory, it will prompt you to quit other applications to
gain more memory.



Recording into SparkLE

Now that the program is properly configured, we're
L A ready to start recording audio into the computer.

When you press Record, you should get the recording screen.

Recording

From this screen,
you will be able to
record audio into
the computer.
You should be
able to discern if
the input is
selected properly.
(The level meters
will dISpIay the : : 0 CURRENT
audio coming into
the computer.) If
you are not
getting any readings there, click on the button in the top
center of the menu that is labeled Device, Setup.

PSerumn |\ MNP0 Couns.. 1+

I i Recording #3 AIFF
[ | Audio Files 44100 Hz |

Sound Input Options ="rc———=H

When you click there, you
can select the input to
use for recording, and

Device  [Built-in

Source  [Sound In

Input Gain Left | ] adjust the gain on the

Input Gain Right | ] input. If this is properly
{ Hold «Command> Key for Stereo ) set, click OK.

O Play Through

Now you're ready to
record. Click on the Record button in the Record Window,
and start playing your source audio. When you're done, click
stop. You can check your audio before leaving the window by
using the transport bars inside the window. Once you're
happy with the recording, click on Done.

The program will save the recording, and start generating a
waveform. When that's done, the audio should be displayed
in the normal window. The top waveform shows the entire
song. The bottom waveform is your zoom window for editing
and processing.
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Before we go any further, it would probably be good practice
to save the project. Save frequently and often. It's a good
practice to get into.

Audio Editing & Processing in SparkLE

Now that the audio is inside the computer, let's go over some
basic techniques that will take your mixdown, and give it the
professional touch!

Tight Leadering - To delete the dead space before and after
the audio, click and drag across the audio that you want to
keep. You can audition the audio by pressing the space bar.
To move the edges of the selection, hold shift, and drag
across to your new selection point. Once the region is as
you want it, drag down from the Edit menu, and select Trim.



Fade - To add a fade to the

beginning or end of a file, simply
select the portion of the file to
be faded, go to the Process
menu, and select Fade. You will
get a menu that offers several
different Fade curves. Choose
the one you want, and press OK.

ok ]

TC|MaxIt Master

EQ. Mix and match. Swap 'em
up. Whatever you need to do to
get the sound you want, go for

it.

The important thing to keep in
mind here is that the plug-ins
are processed in real time. The

processing isn't written to the
hard drive at all.

Normalization - SparkLE also has a normalization function.
This takes your recording, find the loudest point in the audio
clip, then mathematically increases the volume of the audio
clip so that the loudest point is at maximum volume. This is
great for increasing the volume of recordings that were done
too quietly. To normalize the audio file, drag down from the
Process menu and select Normalize.

If you want to apply this processing to the file for use in
another program, you'll need to click on Create File at the
bottom of the Master Window. A pop up window will ask you if
you want to write the
entire file, or just a
selection. Make your
choice, and you're
done! You've just
completely mastered
your audio!

Create File Properties

AudioFile — Process/Result

#® Selection [ Add tail

' Whaole file Frocess into existing file

(e 5]

The Master Screen

Also included with SparkLE are O
several plug-ins for real time
processing. TC|Maxlt is a look
ahead compressor.
SparkOneBand is a single band of
parametric EQ. There's also
TC|Delaylt, a delay processor.

Master —0e=0H

To get to the plug-in control
screen, click on the Windows
menu above, and select Show
Master. The window should pop up
with 4 blank plug-in sockets.

To add a plug-in to the chain,
select a location, and press Add
in the top of the window. The
plug-in screen should show up,
offering controls for the plug-in.

To remove a plug-in, select the plug-in you want to remove,
and press Remove at the top.

The great thing about having several plug ins, is the ability to
mix and match. You can have the maximizer, a delay, and
two bands of EQ. Or, you can have 4 bands of parametric



Adaptec Jam!

CD-R Pro Only

To start assembling your CD, boot up Jam and simply drag
and drop all the song files into the Jam window.
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The songs you have selected for this CD will appear in the
window, along with pause between tracks, time the track
starts, and the track length. You can change the order
simply by dragging the song files around.

There are some powerful real-time (non-destructive)
processing features in Jam that make assembly of
professional sounding CDs a snap. You’ll notice there is a
column for Gain on each song. If your songs are playing back
at different volumes because of varied levels during
recording, you can make fine adjustments here.

Also, if you are trying to have continued play from one track
to another, such as with live recordings, you can do a
crossfade in the Xfade column. For this, this pause between
tracks have to be set to zero. There are different gain curves
that you can experiment with to make the transition as
smooth as possible. (The crossfades are represented by two

curves; each curve represents channel levels over the length
of the crossfade.)

Again, there are far more advanced features included with
this package, but we’ll leave that to the Jam manual.

Once you’ve got your CD assembled, click on Check Speed
in the upper right corner. For the first few CDs you make, we
highly recommend doing test burns first. Depending on what
your source data is coming from, the source drive may not be
fast enough to support 6x burns. This can be even further
complicated if your drive is “fragmented,” meaning the data is
not in a continuous block on the drive. (This happens
frequently when the drive is nearing capacity.) So just to be
safe, run the test before burning so you are sure the system
will run properly. If your system is having trouble keeping up
with the drive, read the “Troubleshooting Underruns” section
at the end of this Guide.

Once the test has

successfully been

completed, go ahead and
click on Write Disc. You
will get a screen that gives
you the option of Write [ camcel | [ writepisc |
Session or Write Disc.

! Start writing now?

[ Simulation Mode

Write Session means you will burn a disc, but you do not
close it off. An application like Adaptec Toast will still be
able to write data information in another Session behind it.

Write Disc means the disc is closed off, and no further
sessions can be recorded behind it. If you are making a CD
that is going to a duplication house, you will want to use
Write Disc. Also, if you have no intention of recording
anything else after the CD, you can close it off.

Once you’ve clicked on your option, the CD will start
recording. When it’s finished, you’re on CD!



Adaptec Toast
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Open Adaptec Toast, and go to the Format menu to select
the type of CD you wish to record. If you are burning an
Audio CD, then choose Audio CD. If you are simply trying to
back up select files from your computer, use Mac Files &

Folders. If you are trying to y

distribute data to both Mac and PC m

users alike, use the 1SO-9660 + Mac Files & Folders %2

format. (Both PCs and Macs can I'I\.?Iogffl'Sﬁ(U)Hyh i :3
ac (]

read those.) e i

The files can be selected by E,?Jéu @

dragging and dropping the files and Enhanced Music CD

folders on the Toast window. To see SCS| Copy

the hierarchy of the disc you are Disc Image

assembling, click on the Data button Multitrack CD-ROM XA

(or the Audio button if you are Audio Tracks EA

making an Audio CD.)

You can move files from one folder to another, create new
folders, or remove files from this screen. To rename the disc,

double click on = ai———

the CD icon and [ Fites [ Layout [ settings |
name it whatever
you like. When
you are through
assembling the
CD, click Done.
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[3 EZ CD Creator
[3 pUTCH
7 EMGLISH
3 FRENCH
[ GERMAN
3 ITALIAN
[ SPANISH
3 QuickTimes02
O QuickTimeInstallCache gdat
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Once you’'ve got
your CD
assemb|ed' click [MewFolder | [ add. | | memove | [ Resolve Aliases

on Check Speed iles £ 52 Directores
e e J

in the bottom.
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As we mentioned

in the Jam burning process, it is wise to try a test burn to get
a feel for the performance of your computer. If your system
is having trouble keeping up with the CDR drive, read the
“Troubleshooting Underruns” section at the end of this Guide.

Once the test has successfully ! Startwriting now?
been completed, go ahead and _

: : . . e G|
click on Write Disc. You will get O Simalstion Mo
a screen that gives you the

option of Write Session or Write
Disc. [ cancel | [ writepisc |

Write Session means you will go ahead and burn a disc, but
you do not close it off. Toast will still be able to write data
information in another Session behind it.

Write Disc means the disc is closed off, and no further
sessions can be recorded.

Once you’ve clicked on your option, the CD will start
recording. When it’s finished, you’'ve recorded your CD!



AudioCatalyst Tutorial

(CD-R Pro Only)

What is MP3?

MP3 has created quite a buzz, but what is it really? MP3 is a
compression format for storing audio with excellent fidelity,
yet only taking approximately 9% of the data space. MP3 is
short for MPEG (Moving Picture Expert Group) type 1, layer
3. If you’re curious about other types of MPEG compression,
you can find their web site at:

http://drogo.cselt.stet.it/mpeg/

What MP3 offers is a way to distribute your music much
easier. Currently, the main uses for MP3 are for personal
players (walkman-type units) and for internet distribution of
audio. You can use MP3 to put a clip of your band on the
internet, or even to exchange musical ideas with someone
else via email.

AudioCatalyst is an MP3 encoder/player. It can encode
regular WAV files to MP3. If you already burned your audio
to a CD, you can also use AudioCatalyst to encode files
directly from the audio CD.

Encoding Options

There are a good deal of options when creating MP3 files.
There are different data rates, CBR vs VBR, and mono vs
stereo. For your first time, try doing 128kbps, CBR and
stereo. That is the typical layout, and the most compatible.
For reference, the terms are defined below.

data rate - Data rate simply defines how much throughput
the MP3 file will take. The data rate most people use is
128kbps (kilobits per second), but it can vary from 32kbps
up to 320kbps. The higher the data rate, the higher the
quality.

CBR vs VBR - In order to capture different sounds with true
clarity, some sounds can take less space... other sounds are
more demanding. CBR (Constant Bit Rate) was the original
spec designed for MP3, and is compatible with virtually all
MP3 players. VBR (Variable Bit Rate) basically adjusts the
amount of data used to encode the sound according to what
is needed. VBR typically sounds better, but older MP3
players may not be able to use it.

mono vs stereo - This is pretty self explanatory, but it is
important to realize that a stereo signal does not necessarily

take twice as much space as a mono signal. (Ain’t
compression skwewy?)

Encoding MP3 Files

To encode audio to

OJ=———— AudioCatalyst——— &
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the bottom of the R e ||| ——————

— Time (elapsed/left) : 0oas18

window, you can
select files to
encode from either
an audio file (such
as AIFF) or from a
CD. Add From File
chooses audio files, and Add From CD chooses tracks from a
CD. The songs will be shown in the list in the left side of the
window.

[~] Player Stop

@ 1999 King Technology Corp

Add from File| | Add From (D

To encode the files, press encode. AudioCatalyst will prompt
you for a location to save the files to. Once you determine
the location, AudioCatalyst will begin encoding.

The player button in the AudioCatalyst window is a
convenience feature allowing you to launch an MP3 player
from AudioCatalyst. We have included QuickTime 4 in this
package which comes with a player, but you o

may use any player you wish. To select | ﬂ

which player you’d like to come up, go to 2

the Player menu and select Set Player. MoviePlayver



Playing MP3 Files

F Pat's Smash Hit!l.mp3
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Playing MP3 files is as easy as selecting the file to play.
This player is the QuickTime 4 Movie Player.

Select an MP3 file by clicking on the File menu and dragging
to New Movie. You will have the familiar browsing windows.
When playing files, remember that the volume on the front of
this player is further adjusted by the master volume for the
computer in the Sound Control Panel.

To get the balance, bass and treble controls,
click on the :: button.

Troubleshooting

Underruns

Let’s start with a basic understanding of what’s involved.
Here are some basic terms you will need to understand to
navigate the world of data transfer:

Access Time - How long does it take from the time the
computer asks a drive for data until the drive starts spitting
it out? This is usually measured in ms (milliseconds).

Throughput (aka Transfer Rate) - Once the drive finds the
information, how fast can it transmit the data? This is
usually measured in MB/sec (megabytes per second).

Fragmented or Optimized - Is the information on the drive
written in one continuous data stream, or is it broken up into
several pieces around the drive? If the data is in one
continuous stream, it is optimized. If it is broken up, it is
fragmented.

Once you understand the previous terms, then we’re ready to
troubleshoot! Let’s first understand the relationship between
all of these.

Think of a disk drive as a book. If you are reading a book
from page one to the end, you can read a certain number of
words per minute. When you read a newspaper, and the story
on page B1 is continued on page B14, you are spending time
looking for the continuation of the story. Suddenly, it takes
longer for you to read the same amount of words. Even worse
is a Choose-Your-Own-Adventure book. With these, you can
only read a few paragraphs before you have to find the next
part. This slows you down considerably.

So it is with hard drives. If everything is streamlined, then
the data will flow quickly. If the drive has to search for all the
parts continuously, the data flow suffers.

So, one suggestion may be to optimize your source drive.
That will put each file in one continuous data stream. You



can do this with a multitude of applications, such as Norton
Utilities.

Another solution is to create a disc image, which will write (in
one continuous stream) all of the information for the CD to a
disk drive, including the directories. This is sometimes
necessary for slower hard disks to operate with faster CD
burn speeds.

Of course, one other solution is just to reduce the recording
speed of the CD-Recorder. Some source disks may just be
too slow for higher speed recording (ie Zip, old 44 meg
SyQuest, etc). Also, if you're just making one quick CD, it
may be faster to simply record the CD at 2x or even 1Xx,
instead of defraging the drive, then burning the CD at 4x.

Other problems

Jam cannot identify the CD-Recorder - There is a file labeled
TEAC CD-R58S. This file must be in the same folder as
the Jam application at boot-up. When Jam starts up, it
looks for these driver files and adds them to their list. This
file MUST REMAIN in the same folder as Jam.

cannot extract audio from my CD-ROM. - If you are trying
to extract audio from an audio CD or trying to copy from CD
to CD, your CD-ROM must be capable of these functions.
(Not all CD-ROMs can do that.) If necessary, the TEAC
CD-R drive that came with this bundle is capable of most of
these types of functions, so you may use the CDR drive to
extract to your hard drive, then burn back to the CD.

The drive is not recording to the blank CDs. - There could be
several causes for this:

1) Make sure the disc you are using is a regular CDR
media. CD-RW discs are not compatible with this drive.
“For Music Only” CDs may also cause problems, as
they are designed for use with consumer component
CD-Recorders.

2) Make sure the CD is right side up. (Some blank media
have no labels, and it can be confusing which side is the
"recording" side.)

3) Make sure the CDR media is on the list of approved
media of this drive. We have tested many types of CDR
media, and the results are posted on our web site at
http://www.tascam.com. The list is kept on the site so
it may be kept as up to date as possible.

4) While the CD-Recorder is recording, make sure the
CDR drive is not agitated. (If you write as vigorously
as | do, even writing the jewel case insert on the same
table as the CD-Recorder is on could shake the unit
enough.) CD Recording requires much more stability
than reading. When reading a CD, players can take
several passes at the data stream if the tracking is
lost. However, CD-Recorders do not have this luxury.
They are recording the information on the CD, and need
to do so precisely the first time.

The system is testing too slow for 6x or 8x recording speeds.

- Chances are there is more processing going on than just
your CD authoring software, or your source drive is too
slow for higher speed burning.

1) If your computer has a lot of applications running in
the background, this can substantially slow the
efficiency of your system. (Common culprits are likely
to be anti-virus software, screen savers, or advanced
network applications.) These can be temporarily
disabled to dedicate more processing horsepower to the
CD authoring software.

2) In recent years, large disk drives have become more
and more affordable, but often the drives many stores
advertise are quite slow. If the drive is too slow, then
you’ll have to try optimizing your drive.

3) Even with optimizing your hard drive, some drives may
still be too slow. (Especially removable media including
Jaz drives, Zip drives. And other similar media.) If this
is the case, you will have to select a slower burn speed.



SparkLE keeps complaining that the
RealTime engine is overloaded. -
The best solution may be to simply
give SparkLE more RAM. (The
more RAM the program has, the
faster it can process everything.)
If all else fails, simply restart
SparkLE. That usually fixes the
problem. In the upper right of the
Master window, there is a CPU
monitor that displays the CPU
load. Check that to see if the CPU
is actually overloaded, or if the
program simply needs more RAM.

SparkLE consistently complains that it had a bad block error.
- Some computers keep showing this error when SparkLE
comes to the end of the audio file. Basically, the computer
ran out of audio to play, and so the program tells you that it
couldn't read "one or more samples"”. The problem is that
the program couldn't ready anymore because there is no
more! There isn't anything wrong, really. Check the box in
the error message that says, "Don't show me these
messages anymore."”, and the error messages will go away
for good.

I'm having problems with the SCSI Card in the computer. -
When you went through the installation process, did you
remember to install the drivers for the card? If those are
not installed, then the drive will not be recognized by any
program.

Technical Support

If you are still experiencing problems with the unit after
reading the previous troubleshooting section, you can check
for more up to date FAQ documents at TASCAM’s web site
at:

http://www.tascam.com
or contact TASCAM Technical Support at:

(323) 726-0303 x627
custser@teac.com



